# TABLE OF CONTENT

1 Introduction ................................................................................................................................................. 7
2 Login dialog ................................................................................................................................................ 7
3 Main window ............................................................................................................................................... 8
   3.1 Main menu ........................................................................................................................................... 9
4 Panels ....................................................................................................................................................... 9
   4.1 Repositories and models ..................................................................................................................... 10
   4.2 Local file explorer ............................................................................................................................. 10
   4.3 File associations ................................................................................................................................. 10
   4.4 Product Structure browser ............................................................................................................... 10
   4.5 CAX viewer ...................................................................................................................................... 11
5 File associations ....................................................................................................................................... 11
6 User management .................................................................................................................................... 13
   6.1 Add user to OpenSimDM™ ............................................................................................................. 14
7 “Repositories and models” panel ........................................................................................................... 15
   7.1 Appearance ....................................................................................................................................... 15
   7.2 Server panel context menus ........................................................................................................... 15
   7.3 Create repository ............................................................................................................................... 16
   7.4 Create model ................................................................................................................................... 17
8 “PS browser” panel ................................................................................................................................. 17
   8.1 “Tree” view ...................................................................................................................................... 18
   8.2 “Details” view .................................................................................................................................. 23
   8.3 “Properties” view .............................................................................................................................. 23
   8.4 Person ................................................................................................................................................ 24
      8.4.1 New ............................................................................................................................................. 24
      8.4.2 Update ....................................................................................................................................... 25
      8.4.3 Remove ..................................................................................................................................... 26
      8.4.4 Assign ....................................................................................................................................... 26
      8.4.5 Determination of access rights ................................................................................................. 27
8.5 Organization ......................................................................................................................................... 28
   8.5.1 New .............................................................................................................................................. 28
   8.5.2 Update .......................................................................................................................................... 29
8.5.3 Remove ................................................................. 29
8.5.4 Assign ............................................................... 29
8.6 Methods .................................................................. 30
  8.6.1 New method ....................................................... 30
  8.6.2 New task ............................................................ 31
8.7 Approval .................................................................. 31
  8.7.1 New ................................................................. 31
  8.7.2 Assign ............................................................ 32
  8.7.3 Final approval ................................................... 33
8.8 Comment ................................................................ 34
  8.8.1 New ................................................................. 34
  8.8.2 New feedback ................................................... 34
  8.8.3 Remove ............................................................ 34
8.9 Property ................................................................. 34
  8.9.1 New ................................................................. 34
  8.9.2 Remove ............................................................ 35
  8.9.3 Assign ............................................................ 36
8.10 Export to archive .................................................... 36
8.11 Import from archive and model ................................. 38
8.12 Child folders .......................................................... 39
  8.12.1 New ................................................................. 39
  8.12.2 Remove ............................................................ 39
  8.12.3 Copy ............................................................... 40
  8.12.4 Cut ................................................................. 40
  8.12.5 Paste .............................................................. 40
  8.12.6 Paste link ........................................................ 40
8.13 Folder version ........................................................ 41
  8.13.1 New folder version ........................................... 41
  8.13.2 Show version .................................................. 41
  8.13.3 Shift version .................................................... 42
  8.13.4 Remove version ............................................... 42
8.14 File handling ........................................................ 43
  8.14.1 Assign and upload files ..................................... 44
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.14.2</td>
<td>New external file reference</td>
<td>45</td>
</tr>
<tr>
<td>8.14.3</td>
<td>Download</td>
<td>46</td>
</tr>
<tr>
<td>8.14.4</td>
<td>Open</td>
<td>46</td>
</tr>
<tr>
<td>8.14.5</td>
<td>Open with</td>
<td>46</td>
</tr>
<tr>
<td>8.14.6</td>
<td>Query</td>
<td>46</td>
</tr>
<tr>
<td>8.14.6.1</td>
<td>Model Query</td>
<td>48</td>
</tr>
<tr>
<td>8.14.6.2</td>
<td>Node Query</td>
<td>48</td>
</tr>
<tr>
<td>8.14.6.3</td>
<td>Element Query</td>
<td>48</td>
</tr>
<tr>
<td>8.14.6.4</td>
<td>Curve Element Property Query</td>
<td>49</td>
</tr>
<tr>
<td>8.14.6.5</td>
<td>Surface Element Property Query</td>
<td>49</td>
</tr>
<tr>
<td>8.14.6.6</td>
<td>Point Element Property Query</td>
<td>50</td>
</tr>
<tr>
<td>8.14.6.7</td>
<td>Directionally explicit Element Property Query</td>
<td>50</td>
</tr>
<tr>
<td>8.14.6.8</td>
<td>Material Property Query</td>
<td>50</td>
</tr>
<tr>
<td>8.14.6.9</td>
<td>Constraint Element Query</td>
<td>50</td>
</tr>
<tr>
<td>8.14.6.10</td>
<td>Applied Load Query</td>
<td>51</td>
</tr>
<tr>
<td>8.14.6.11</td>
<td>Displacement Query</td>
<td>51</td>
</tr>
<tr>
<td>8.14.6.12</td>
<td>Stress and Strain Query</td>
<td>51</td>
</tr>
<tr>
<td>8.14.6.13</td>
<td>Element Forces from Node Force Balance Query</td>
<td>51</td>
</tr>
<tr>
<td>8.14.6.14</td>
<td>Displacement Survey</td>
<td>52</td>
</tr>
<tr>
<td>8.14.6.15</td>
<td>Stress or Strain Survey</td>
<td>52</td>
</tr>
<tr>
<td>8.14.6.16</td>
<td>Element Forces from Node Force Balance Survey</td>
<td>52</td>
</tr>
<tr>
<td>8.14.7</td>
<td>Validate</td>
<td>52</td>
</tr>
<tr>
<td>8.15</td>
<td>Link files and folders to folder</td>
<td>54</td>
</tr>
<tr>
<td>8.16</td>
<td>Collections</td>
<td>55</td>
</tr>
<tr>
<td>8.16.1</td>
<td>Baselines</td>
<td>56</td>
</tr>
<tr>
<td>8.16.1.1</td>
<td>New baselines</td>
<td>56</td>
</tr>
<tr>
<td>8.16.1.2</td>
<td>Show baseline</td>
<td>57</td>
</tr>
<tr>
<td>8.16.1.3</td>
<td>Remove baseline</td>
<td>58</td>
</tr>
<tr>
<td>8.16.2</td>
<td>In-work package</td>
<td>58</td>
</tr>
<tr>
<td>8.16.2.1</td>
<td>New in-work package</td>
<td>58</td>
</tr>
<tr>
<td>8.16.2.2</td>
<td>Show in-work package</td>
<td>59</td>
</tr>
<tr>
<td>8.16.2.3</td>
<td>Remove in-work package</td>
<td>59</td>
</tr>
<tr>
<td>8.16.3</td>
<td>LOTAR Archive</td>
<td>59</td>
</tr>
</tbody>
</table>
8.16.3.1 New LOTAR AIP .................................................................................. 59
8.16.3.2 Show LOTAR AIP ............................................................................. 60
8.16.3.3 Remove LOTAR AIP ........................................................................ 60
8.17 Find ......................................................................................................... 60
9 Local file explorer ...................................................................................... 61
10 Help panel .................................................................................................. 62
11 Geometry and FEA viewer ........................................................................ 62

**TABLE OF FIGURES**

- Figure 1. Login dialog.................................................................................. 7
- Figure 2. Main window .................................................................................. 8
- Figure 3. Panel operations ......................................................................... 10
- Figure 4. The three panels of the product structure browser .................... 11
- Figure 5. “SimDM file association management” panel .............................. 12
- Figure 6. Add a file association via file extension ..................................... 13
- Figure 7. User management panel ............................................................. 14
- Figure 8. Create a new OpenSimDM™ user ............................................. 14
- Figure 9. “Repositories and models” panel .............................................. 15
- Figure 10. Context menu for models ......................................................... 16
- Figure 11. Context menu if no model is selected ..................................... 16
- Figure 12. Dialog to create repository ...................................................... 16
- Figure 13. Dialog to create a model / product structure .......................... 17
- Figure 14. Tool bar in “PB browser” panel .............................................. 18
- Figure 15. Product structure context menu for administrators ................ 19
- Figure 16. Folder context menu for administrators .................................. 21
- Figure 17. “Details” view .......................................................................... 23
- Figure 18. “Properties” part of the “PS browser” panel ......................... 24
- Figure 19. Dialog to create a person ......................................................... 25
- Figure 20. Examples of a removed, but still assigned person and an organization .......................................................... 26
- Figure 21. Dialog to assign person to folder .......................................... 27
- Figure 22. Dialog to add organization ...................................................... 28
- Figure 23. Dialog to assign organization to folder .................................. 29
- Figure 24. Dialog to add method ............................................................ 30
- Figure 25. Dialog to create a task ............................................................ 31
- Figure 26. Dialog to define a type of approval ........................................ 32
- Figure 27. Dialog to assign approval ...................................................... 33
- Figure 28. Dialog for giving final approval ............................................. 33
Figure 29. Dialog to add comment ................................................................. 34
Figure 30. Dialog for the definition of properties ................................................. 35
Figure 31. Assigning a property to a folder ........................................................ 36
Figure 32. Export to archive options ...................................................................... 37
Figure 33. Alert window after ZIP package is downloaded ..................................... 37
Figure 34. Pop-up window for “Import from model...” ............................................ 38
Figure 35. Dialog to create child folder ................................................................. 39
Figure 36. Folder remove dialog ........................................................................... 40
Figure 37. Link object in the detail view of a folder ............................................... 40
Figure 38. Question to create new folder version ................................................... 41
Figure 39. “Show version” dialog ......................................................................... 41
Figure 40. A folder version in its own product structure browser panel .................. 42
Figure 41. “Shift version” dialog .......................................................................... 42
Figure 42. Files context menu for AP209e2 files .................................................... 43
Figure 43. “New file -> Upload...” dialog .............................................................. 44
Figure 44. Alert window after upload is finished ..................................................... 45
Figure 45. Alert window after file is downloaded ................................................... 46
Figure 46. Queries implemented in this release ....................................................... 47
Figure 47. The text query panel is to the left .......................................................... 47
Figure 48. Validation options .................................................................................. 53
Figure 49. Message after completed AP209e2 validation ....................................... 53
Figure 50: Information window for “Check STEP-files...” ..................................... 54
Figure 51: Overview of STEP-files given by “CheckSTEP-files...” function .......... 54
Figure 52. “File reference” dialog ....................................................................... 55
Figure 53. “Folder reference” dialog ................................................................. 55
Figure 54. Three collection type sub-menus in top folder context menu ............... 56
Figure 55. The baseline creation panel ................................................................. 57
Figure 56. “Show baselines” opens another product structure panel on the left side ... 58
Figure 57. Creation of an In-work package ........................................................... 59
Figure 58. Creation of a LOTAR AIP .................................................................. 60
Figure 59. Example of a “Find”-operation ............................................................. 61
Figure 60. “SimDM viewer” panel ....................................................................... 63

TABLE OF TABLES

Table 1: Differences in types of folder collections ............................................... 55
Table 2. List of wildcard options for the Find... function ...................................... 61
1 Introduction
This is the reference manual to the OpenSimDM™ application. The reference manual lists all available OpenSimDM™ functionality. In addition to this reference manual there is a Usage Guide; it is recommended to read the Usage Guide first.

OpenSimDM™ is a client desktop application that communicates via web-services with the OpenSimDM™ server. The client is also called “SimDM browser”. The application fulfills the following purposes:

- Management of design and engineering analysis data
- Product structure driven file management
- Resource allocation
- Collaboration and communication
- Separation of responsibilities
- Viewing of design and engineering data
- Textual queries into AP209e2
- Archival of data packages

2 Login dialog
After start of the SimDM browser its main window is opened, and the “Login to SimDM server” dialog appears (see Figure 1).

![Login to SimDM server dialog](image)

**Figure 1. Login dialog**

The “SimDM server:” combo box contains predefined names of connections. Parameters of connections can be changed manually in `simdm_client.settings.xml`, which is placed in the installation folder of the application in Windows XP. The file is stored in the following folder in Windows 7:

```
c:\Users\[user_login]\AppData\Local\VirtualStore\Program Files (x86)\
```

By default, connection settings point to the following local URL of the SimDM web server:
If the “Cancel” button is clicked, the dialog disappears and no access is given to the system. It is possible to launch the dialog again by the “Server” → “Login” menu item. Click the “Login” button to get access to the selected server.

3 Main window

The main window of the application could look like in Figure 2 (left and right panel containers have open panels).

SimDM browser has a dual panel user interface. Such user interface is based on the orthodox file manager (OFM) principle, also known as Commander-like file managers, the family of file managers based on the venerable Norton Commander interface. As opposed to file managers, the SimDM browser serves not only the functionality to work with files; also other types of information are managed, such as product structures, persons, organization and approvals. These data and their corresponding functionality are grouped into different types of panels.

Panels are grouped into two panel containers: left and right. Many panels can be open at the same time, but each panel container shows only one panel at a time. Panel positioning is controlled by the buttons to the right of the “help” menu entry. It is possible to switch between panels in the panel container; use “Show open panels list” button (down-arrow) on the tool bar of the panel container for that. A panel can be moved into the opposite panel container or closed (deleted from both panel containers). And, the two panel containers can be organized so that only one of them is visible; that is, a single panel may take your entire screen.
3.1 Main menu
The main menu (see Figure 2) contains the following menu items

Server
- Login – “Login” dialog appears (see chapter 2), the same as at system start-up.
- Logout – closes the current session.
- Change password… – changes password for the current user.
- Export models – All available Product structures are exported to its own zip archive on the server side.
- Exit – shuts the application down.

View
- Repositories and models – opens the “Repositories and models” panel or brings the open one to the front (see chapter 4.1)
- User management – opens “User management” panel. The menu item is available for “superuser” only. See chapter 6 for details.
- Local File Explorer – opens a “Local file explorer” (see chapter 4.2); several clicks open several explorers
- CAX viewer – opens a panel with VCollab Presenter (geometry and analysis viewer) (see chapter 11)
- Status Bar – opens and closes the status bar (see Figure 2)
- Customize… - adapts appearance of panels, menus and commands to your personal preferences
- Left Panel List – shows the list of opened panels in the left panel container
- Right Panel List – shows the list of opened panels in the right panel container

Tools
- File associations – opens “File associations” panel or brings the open one to the front (see chapter 4.5)
- Find in product structure… - opens “Find” panel for selected “PS browser” panel.

Window
Presents a list of all opened panels, both of left and right panels.

Help
- About – opens window with SimDM system information
- Help – opens panel with user help information (not implemented yet)

4 Panels
The five types of panels are introduced in the following paragraphs. The “Server content”, “Local file explorer” and “CAX viewer” panels can be opened by entries in the “Views” menu item. The following operations can be done with all types of panels:
- Move current panel to the opposite (left or right) side.
• Retrieve list of available (opened before) panels in the left or right panel container\(^1\). The appropriate panel is shown when it is selected from the list.

• Close current panel.

These three operations are available in the right (and left) panel captions as three buttons (see Figure 3).

![Figure 3. Panel operations](image)

### 4.1 Repositories and models

The “Repositories and models” panel displays repositories and models in the SimDM database. At system start it appears on the left side. Each model represents a self-contained Product Structure (PS). References across model boundaries are not supported.

Note: The current server side installation includes the test data model “Ultralight_Glider” in repository “InitialRepository”.

### 4.2 Local file explorer

This panel represents the file structure on the local client machine as a tree. It is possible to Drag-and-drop files between “Local file explorer” and “Product Structure browser” panels.

Note: The “Windows Explorer” application can be used instead of the “Local file explorer” panel. But it is only possible to drag one (or several files) from “Windows Explorer” and drop it into the “Product Structure browser” panel, not vice versa.

### 4.3 File associations

The “File associations” panel (see 5 for details) is opened by the main menu entry “Tools>File associations”. Files from the SimDM server are opened according to their extensions. This panel manages associations between file extensions (.doc, .pdf, .txt and so on) and external applications that will be used to open files that are stored in or referenced from SimDM.

### 4.4 Product Structure browser

This panel represents Product Structure (PS) data, such as Folder, Approval, Person and attached File. The panel offers the following three views; these are from left to right the following:

- **Tree.** FOLDER objects are shown in a tree structure, that is, with their parent-child relationships. The tree-view behaves like a folder structure in a file system.

- **Details.** The Details-view displays the content of a selected folder, such as, child folder objects, approvals, files and so on. Folder meta data may be viewed by information category; there is one tab for each category (“Approvals”, “Organizations”, “Persons” and so on). Or, all types of objects can be seen together in the “All items” tab.

- **Properties.** Each item in the Details-view may have several properties. All properties of a selected item are presented in the grid of the Properties-view.

---

\(^1\) This operation can be performed by using hot keys (Alt+F1 – for the left panel container, Alt+F2 – for the right panel container).
Figure 4. The three panels of the product structure browser

Only the Tree-view is shown by default. The other views can be shown/hidden by using toolbar buttons inside the “Product Structure browser” panel.

Several Product Structure browser panels can be open simultaneously, but maximum two can be viewed concurrently.

4.5 CAX viewer

VCollab Presenter is started in this panel as an ActiveX component. Functionality for loading and manipulating the view of a 3D model is available from the main menu and from a context menu. Please, refer to the context menu “Help…” entry for guidance on how to apply this functionality.

Besides opening this panel manually form the “CAX viewer” menu item, it will start automatically when you open a file that was converted to the CAX format at upload time (AP209e2, AP203 and NASTRAN files). Starting VCollab takes some time – please, be patient.

5 File associations

The “SimDM file association management” panel can be shown by choosing the “Tools” → “File associations” main menu item after having logged in.

The panel presents dependencies between file extensions (.txt, .pdf, .doc), descriptive file type names and paths to one or several viewer applications that are adequate to open this sort of file.

Descriptive file type names are in the “File type” column. Usually it is a short human readable text; for example: “ABAQUS FILE”, “CATIA V4”, “NASTRAN Output File”.

Column “External viewer” can contain a path to an external executable that is used by default to open files of that specific type from the SimDM browser. If a path is not set, the text “By system default” is shown. This means that such files are opened from the SimDM browser by the application that is registered for this specific file extension in the client machine, that is, normally VCollab Presenter.

Note: If you should change the default setting and then want to redo your change, simply empty the path in the “External viewer” field. This will again make VCollab the selected application.
Column “Preferred” indicates whether the entry in column “External viewer” is the preferred tool to open the correspondent type of file.

Note: Uploaded .stp-files of types “AP203” or “AP209” and NASTRAN-files with extensions .bdf and .op2 are converted to CAX. Unless “Preferred” indicates anything else, the SimDM internal CAX viewer tool, VCollab Presenter, will be used to open the uploaded file (“Open” context menu item).

Column “Command options” represents command line arguments for specified external viewer. Command line option <FILE> represents the file that will be opened by the external viewer. Additional command line parameters that are accepted by the specified external viewer may be added.

Figure 5 shows the panel where the table is grouped by the “Description” column. Any column header can be dragged and dropped into a place above the table to group the table by that column.

![SimDM file association management panel](image)

**Figure 5. “SimDM file association management” panel**

The table is editable. New items can be added (“Add” button), edited (“Edit” button) and removed (“Remove” button).
A single file extension may be associated with one or several tools. To give the user a selection of applications to open a file with, use the “File association:” “Add”-command (see Figure 6). Fill into the pop-up window the same extension name that there is a file association entry for already. Enter a description into the field “File type:” and into “External viewer:” the path to the executable on your machine or network.

In case of several tools, the following applies:

- The file extension editor has a checkbox where you can specify that this tool is the preferred or default tool (see Figure 6). The preferred tool is the tool that shall be started when you double-click on a file with the corresponding extension, even with more than one tool being assigned to the file type.

- The “Open with” command (right-click menu for a file) displays a form where you can select which tool shall be started.

### 6 User management

Each user of OpenSimDM™ has a login identifier, which gives access to the OpenSimDM™ client and server. Such login identifiers are defined in the “User Management” panel (see Figure 7). OpenSimDM™ is delivered with several users defined. Each user has password “db”.

---

**Figure 6. Add a file association via file extension**

A single file extension may be associated with one or several tools. To give the user a selection of applications to open a file with, use the “File association:” “Add”-command (see Figure 6). Fill into the pop-up window the same extension name that there is a file association entry for already. Enter a description into the field “File type:” and into “External viewer:” the path to the executable on your machine or network.

In case of several tools, the following applies:

- The file extension editor has a checkbox where you can specify that this tool is the preferred or default tool (see Figure 6). The preferred tool is the tool that shall be started when you double-click on a file with the corresponding extension, even with more than one tool being assigned to the file type.

- The “Open with” command (right-click menu for a file) displays a form where you can select which tool shall be started.

### 6 User management

Each user of OpenSimDM™ has a login identifier, which gives access to the OpenSimDM™ client and server. Such login identifiers are defined in the “User Management” panel (see Figure 7). OpenSimDM™ is delivered with several users defined. Each user has password “db”.
Figure 7. User management panel

6.1 Add user to OpenSimDM™

The User management panel enables you to add more users. Selecting “Add” launches the pop-up window as seen in Figure 8.

Figure 8. Create a new OpenSimDM™ user

OpenSimDM™ users are assigned types of access to the system. Users may play two types of roles:

- UserManager² – can create/update/delete users.
- SystemManager – can create new product structures (see 7.4), create new login identifiers and has the rights of a SystemUser.
- SystemUser – can play roles in product structures as Admin, Editor or Reader (see 8.4.4).

A SystemManager typically creates a product structure top item and the main product structure tree below; SystemUser will extend this with branches as needed.

Note: Persons with login identifiers that are not explicitly assigned to a product structure will only see model names in the repositories and models panel, but will not be able to open models in the product structure browser.

² Only “superuser” is defined with UserManager role.
New users will be given the following default password: “<login identifier>_simdm”.

7 “Repositories and models” panel
If login is successful, the “Repositories and models” panel is opened in a panel container. This panel is closed and opened by the following main menu item:

“View” → “Repositories and models”

7.1 Appearance
![Figure 9. “Repositories and models” panel](image)
Appearance of the panel can be seen on Figure 9. It consists of three parts: repositories, models and information part.

The left side of the panel contains the list of repositories that are available to store models with Product Structures (PS). New repositories can be created using the context menu (right-click for right-handed mouse) for this part of the panel.

Each repository can have zero, one or many models. The right side of the panel contains the list of models for the selected repository. New product structure models can be created either from scratch or can be imported from an archive package (see 8.11).

The lower part of the panel includes a status view, that is, name, description, created date and so on for the selected model.

7.2 Server panel context menus
The left side with the repositories has only one menu item in its context menu – “Create repository…”

The right side has two context menus, one for a selected model (see Figure 10) and another one if no model is selected (see Figure 11).
The following menu items are available.

- “Open” – opens product structure (PS) in a separate “PS browser” panel (see chapter 8). Mouse double click can be used instead of this menu item.
- “Info” – opens table with information about the product structure.
- “Create model…” – opens dialog to create a new model.
- “Delete model…” – opens dialog to confirm the permanent removal from the database of the model and all the AP209e2 models derived from it.
- “Import from archive…” – retrieves an archived product structure or baseline (see 8.11 Import from archive) into a new model.

### 7.3 Create repository

When “Create repository…” context menu item is selected, the following dialog appears (see Figure 12). Both text fields are empty by default.

**Figure 10. Context menu for models**

**Figure 11. Context menu if no model is selected**

**Figure 12. Dialog to create repository**
ISO 10303 STEP and, thus, SimDM require special syntax for repository names. It needs to start with an ASCII letter, followed by ASCII letters, digits and underscores. Blanks and punctuation symbols are not allowed. It is not possible to enter invalid symbols.

Description can be multiline text with any characters.

7.4 Create model

When the “Create model…” context menu item is selected, the following dialog appears (see Figure 13). The first item to be selected is in the “Type” combo box. The “Name” text field proposes a default name for the PS.

The “Model” text field contains the name that will be given to the SimDM model for this PS. The same constraints for valid characters apply as for SimDM repository: it should start with an ASCII letter, followed by ASCII letters, digits and underscores. Blanks and punctuation symbols are not allowed. It is not possible to enter invalid symbols.

“Description” and “Comment” are optional text fields.

The current user is automatically assigned to the Product Structure. The “Login” attribute of that person object contains the login credentials of the current SimDM user. This person becomes the manager of this PS.

A top folder object will be created for the PS that contains the following additional attributes:

- Creator – the person who created the PS.
- Introduced – the date and time when the PS was created. The local time is used.
- Model – the name of the SimDM model where the PS is stored persistently.
- Persons – the person who created the PS; although being an aggregate, only one element is stored.

8 “PS browser” panel

The “PS browser” panel is opened either by selecting the “Open” context menu item for models in the “Repositories and models” panel or by double-clicking on a model name. The “PS browser” panel opens opposite to the “Repositories and models” panel. The caption at the top of the panel has the following format:
_Repository_/Model - Person: _user_login_ (_user_role_)  

Where _Repository_ - SimDM repository name, _Model_ - SimDM model name, _user_login_ - login of logged in user, _user_role_ - user role for the current PS (Admin, Editor or Reader).

The “PS browser” panel contains three views: Tree, Details and Properties. By default only the Tree-view is shown. The views can be shown or hidden by using the tool bar in the panel (see Figure 14).

8.1 “Tree” view

The left view (Tree) includes the product structure as tree. Top folder and children items have different context menus (see Figure 15 and Figure 16).

Note, the content of menus is dependent on user access rights for the top folder and each subordinate folder (see 8.4.5 for how folder access rights are determined). A user with “admin” access rights will be able to see all menu items represented in Figure 15 and Figure 16. A user with “editor” access rights will be able to see less menu items. A user with “reader” access rights will be able to see only “Add comment…”, “Copy”, “Info…” and “Export to archive…” menu items. A user without any access rights to a folder, will not be able to see any context menu items for this folder.

The top folder represents the product structure itself. Besides children items, it may be assigned the following types of resources:

- persons,
- organizations,
- approvals,
- properties,
- methods.

These resources are definitions only. They may be assigned to individual children items as the product structure evolves. First then a person, for example, gets a role and a property a value. The following rules apply:

- All resources are available to all children items in a product structure, also to new versions of these.
- Resources may be removed. If they at that point in time, were already used and assigned, these assignments will not be removed. However, the resource will not be available any more for new assignments.
- Resources can not be assigned to children items that are in read-only mode (which may be either because the user only has read-only access or because the item has been finally approved and is, therefore, frozen).
• The resources themselves, however, can be edited – by users with proper access rights - even though their assignments may not. All children of a product structure may be frozen; anyhow, it will be possible to change the name of a person who is assigned to one or several of these children.

![Product structure context menu for administrators](image)

**Figure 15. Product structure context menu for administrators**

The context menu for a product structure top folder consists of the following menu items:

• “New approval…” – opens dialog to create “approval” definition object for later use in assigning approvals to folders (see 8.7.1). The created approval will appear in the middle (Details) view. Only administrators can perform this function.

• “New child…” – opens dialog to create a first level folder (see 8.12).

• “New comment…” – opens dialog to create “comment” object (see 8.8). Created comments appear in the middle (Details) view.

• “New task method…” – opens dialog to create “method” object (see 8.6). Methods may later be used in task descriptions (see 8.6.2). The created method will appear in the middle (Details) view. Only administrators can perform this function.
- “New organization…” – opens dialog to create “organization” object (see 8.5.1). The created organization will appear in the middle (Details) view. Only administrators can perform this function.
- “New person…” – opens dialog to create “person” object (see 8.4.1). The created person will appear in the middle (Details) view. Only administrators can perform this function.
- “New property…” – opens dialog to create “property” object (see 8.9.1). The created property will appear in the middle (Details) view. Only administrators can perform this function.
- “Baseline” - “New baseline…” – opens dialog to create a baseline and define its contents (see 8.16.1.1). Only administrators can perform this function.
- “Baseline” - “Show” - ... – lists all available baselines and opens the contents of the one selected in a separate panel (see 8.16.1.2).
- “Baseline” - “Remove” - ... – lists all available baselines and removes the selected one after confirmation (see 8.16.1.3). Only administrators can perform this function.
- “In-work package” – contains menu items similar to “Baseline” (see 8.16.2).
- “LOTAR package” – contains menu items similar to “Baseline” (see 8.16.3).
- “Find…” – opens panel search form to specify criteria for finding text strings in the database (see 8.17).
- “Rename…” – opens dialog to change the name of top folder.
- “Expand/Collapse” – expands or collapses the branch below the selected top folder.
- “Final approval…” – assigns a final approval to the product structure and its entire contents (see 8.7.3). A final approval is required to include a folder in a baseline. Only administrators can perform this function.
- “Export to archive…” – stores a zip-file that includes the AP209e2 STEP file of the SimDM management data and the files that are attached to the entire product structure in a user-defined location (see 8.10).
- “Import from model…” – copies the contents of a different model and possibly different repository as branch to the current folder.
- “Import Product structure…” –
- “Paste” – adds a copied or cut tree branch (only “folder” objects, not files) to the selected folder. Requires that a folder was copied or cut.
- “Lock” -
- “Info…” – opens table with information about the product structure.
Figure 16. Folder context menu for administrators

The context menu for child elements consists of the following menu items:

- “New folder” → “New child…” – opens dialog to create a sub-folder (see 8.12.1).
- “New folder” → “New folder version…” – opens dialog to create a version for the selected folder (see 8.13.1).
- “New comment…” – opens dialog to create “comment” object (see 8.8). Created comments appear in the middle (Details) view.
- “Check STEP files…” – (see 8.14.7)
- “New task…” – opens dialog to assign a task to the selected folder (see 8.6.2). The created task will appear in the middle (Details) view.
• “New File” → “External link…” – opens dialog to assign the path of a file to the selected folder (see 8.14.2).
• “New File” → “Import Product structure…” –
• “Show version” – This menu item only appears for folders with two or more versions. Versions are denoted by integer values like the following: “1”, “2”, “3” and so on³. The integer value that represents the current folder version is greyed and disabled. When selecting a version number, the correspondent folder version is shown in a new “PS browser” panel (see 8.13.2).
• “Shift version” – This menu item only appears for folders with two or more versions. The menu shows the identifiers of the available folder versions, such as, “1”, “2”, “3” and so on⁴. When selecting this menu item, the correspondent folder version will be used as current folder version and will replace the previous version as child to the current parent folder version (see 8.13.3).
• “Assign approval…” – opens dialog to assign one of the approvals that are defined for this product structure to the selected folder (see 8.7.2). The created approval will appear in the middle (Details) view. Only administrators can perform this function.
• “Assign organization…” – opens dialog to assign an organization to the selected folder (see 8.5.4). The created organization will appear in the middle (Details) view. Only administrators can perform this function.
• “Assign person…” – opens dialog to assign a person to the selected folder (see 8.4.4). The created person will appear in the middle (Details) view. Also the default access rights for the person may be changed here. Only administrators can perform this function.
• “Assign property…” – opens dialog to assign a property to the selected folder (see 8.9.3). The created property will appear in the middle (Details) view.
• “Rename…” – opens dialog to change name of selected child element.
• “Update…” – opens dialog to update properties (name, description and type) of a selected folder.
• “Remove” – removes selected folder and subordinate branches (see 8.12.2).
• “Expand/Collapse” – Expands or collapses the next level below the selected folder.
• “Lock” – person assignment is created. The assignment has type either "exclusive_admin" or "exclusive_editor" (depends on current person access rights). The menu item is changed to "Unlock"
• “Unlock” – The menu item is contra of :Lock”. Person assignment is updated. The assignment type is changed from "exclusive_admin" or "exclusive_editor" to “admin” or “editor”
• “Final approval…” – assigns a final approval to a folder and its subordinate branches (see 8.7.3). A final approval is required to include a folder in a baseline. Only administrators can perform this function.
• “Export to archive…” – stores a zip-file that includes the AP209e2 STEP file of the SimDM management data and the files that are attached to the selected folder and its subordinate branches in a user-defined location (see 8.10).
• “Import from model…” – copies the contents of a different model and possibly different repository as branch to the current folder.
• “Copy” – remembers selected folder and its subordinate branches (see 8.12.3). The collection can be pasted to another parent in the same product structure.

³ The count of menu items is equal to the number of folder versions.
⁴ The number of menu items is equal to the number of folder versions.
• “Cut” – remembers selected folder and its subordinate branches and removes them after paste (see 8.12.4). The collection can be added to another parent by “Paste”.
• “Paste” – creates previously copied or cut folder and its possibly attached branches below selected folder; also meta data are pasted (see 0).
• “Paste link” – Creates link of copied folder (or file)
• “Info…” – opens table with information about the selected folder.

8.2 “Details” view
The middle view (Details) represents top folder content (children folders, approvals, persons, organizations…) or the content of a selected folder (children folders, assignments, attached files, references, comments…). The view can be shown/hidden by toggling the “Details” button on the tool bar (see Figure 14).

There are a number of tabs to represent either all kinds of objects (“All items” tab) or objects by their kind (“Children”, “Approvals”, “Persons” and so on).

“All items” tab represents all kind of objects as a list with an icon for each item (see Figure 17).

![Figure 17. “Details” view](image)

The fist item of the list is the special item “..”. The “Details” view will display the content of the next higher level (one level up) of the PS tree by double-click on the “..” item. The same happens if the “Enter” key is pressed when this item was selected.

The “Details” view displays the content of the next lower level (one level down) of the PS tree by double-click on the folder item. The same happens if the “Enter” key is pressed when the folder was selected.

Each object on the list has its own context menu.

The remaining tabs (“Children”, “Approvals”, “Persons” and so on) display one kind of object per tab. Each item type in “All items” tab has its own context menu items. The content of the context menu depends on the user’s access rights to the selected top folder. For example, user with “reader” access rights is not able to use menu items concerning functionality for editing. User, who does not have any access rights to a folder, is not be able to see any content of a folder, selected in a “Tree” view.

8.3 “Properties” view
The right part of the panel (“Properties”) displays scalar and aggregated properties (attributes) of a selected object (see Figure 18).
The values of a selected object can not be changed in the “Properties” grid, only browsed.

### 8.4 Person

#### 8.4.1 New

A new person object can be added to the Product Structure as a user. The person is assigned default access rights, which may be changed (“Assign person” functionality) for each PS folder. The following dialog appears (see Figure 19) after the “New person…” context menu was selected.
By default all input fields are empty. The greyed texts are proposals for input and select values. The combo box “Type” contains the following possible types for person access rights (see 6):

- Admin
- Editor
- Reader
- Undefined

The administrator (admin) defines the entire infrastructure for his/her product structure in terms of resources, methods, properties, organizations and types of approval status. Administrators can include other persons with login access to OpenSimDM™ to his/her product structure and restrict the access rights for these persons to the product structure and to individual folders in it. Only administrators can apply final approvals as needed for baselining. And only they can create baselines. Administrators may assign a person as administrator or editor of a branch and will typically include a task description with this assignment.

Editors fill folders with contents in terms of subordinate folders and files. Different editors may assign their approvals to folders. The folder responsible will respond with feedback to a task description.

Readers can browse through the product structure contents.

The combo box “Login” contains available SimDM logins, but it is possible to write login names of not yet created SimDM users instead.

A person has a name in addition to a login name.

Note: It is currently possible to assign different names to the same login-name in different product structures. This feature will probably change in future OpenSimDM™ releases so that a single login-name is always assigned the same person name.

Text fields “Description” and “Comment” are optional and can be omitted.

### 8.4.2 Update

A person object can be edited by selecting “Update…” context menu item for selected person object in “Details” view. The same dialog (see Figure 19) appears. Text in all fields can be changed. Person object is updated by clicking “OK” button.
8.4.3 Remove
A person is removed by the “Remove” entry in the context menu when you right-click on a person’s name in the “All Items”-tab of the detail view.
The same entry is used to remove a person both from its assignment to a folder and from the entire model.

Figure 20. Examples of a removed, but still assigned person and an organization
To remove a person from the model select the top folder of the model and select “Remove”. If the person is assigned to a folder within the selected model, he/she will not be removed, but can not be assigned any more. This is indicated by the name of the person being struck through in the detail view of the top folder. The assignment occurrences to lower level folders will not change appearances. Such partial removal can be undone by using the “Update …” entry in the person context menu on the top folder.

8.4.4 Assign
Person assignment can be used to change default access rights for a specified person (user with login credentials) in the selected folder (branch of Product Structure). The following dialog appears (see Figure 21) after selecting “Assign person…” context menu for the current folder.
Combo box “Person” contains all persons that are defined for this PS. Combo box “Type” contains the following types of access rights:

- Admin – user has administrator (manager) access rights. User can create new persons, assign access rights for them, approve actions and so on.
- Editor – user is an editor. User can create new folders, upload files and make some updates.
- Reader – user can not update the product structure, but can add comments to objects.
- [No access] – user looses all access rights for the specified folder and its underlying branch(es).

An assignment object may be given a name. This should be different from the name of the assigned person. Text fields “Description” and “Comment” are optional and may be omitted.

Note: For repeated assignments of the same person to the same folder the latest assignment will overwrite the previous one.

### 8.4.5 Determination of access rights

The following basic rules apply for granting product structure access rights to persons with a SimDM login account:

1. Persons who shall have any type of access to a product structure need to be defined in the top folder of this structure (see menu item “New person…”, 8.4.1). In this operation persons may be assigned one of the following roles: admin, editor or reader. A person will have this role per default for all children folders of this product structure unless other roles are assigned locally.

2. A person may be assigned to any sub-folder and, thus, be given a different role than the default role (see menu item “Assign person…”, 8.4.4).

3. A person may be member of organizations. An organization may be assigned to sub-folders, and in that operation the organization and its members are assigned one of the following access rights: administrator (manager), editor, reader, [Use default type] or [No access].
4. The combination of assignments of person and organization to a folder specifies the access rights of a person and will result in one of the following four roles: administrator (manager), editor, reader or [No access].

The calculation of the access rights for a person in a folder is based on the following priorities:

1. Main priority is the role given by the assignment of the person to the folder. E.g. a person with any default role who may be member of any group could be assigned to a folder with role equal ADMIN (manager), EDITOR (writer), READER or NO ACCESS (ineligible). After that the person will have this access level to the folder and its children (unless the person is assigned to one or several sub-folders with different access rights).

2. Second priority is the role given by the group (organization) assignment. It is taken into account for persons without explicit person assignment to the sub-folder. Over the folder domain (including child folders) all members of the assigned group (organization) will be granted the same role (that could be reassigned on child level).

3. Third priority is the role inherited by the person from the parent (using) folders of the current folder. Normally a person inherits access rights (role) from the parent folder (if there are no direct person or organization assignments in the folder). If the folder is child of several parents (the OpenSimDM™ server provides this feature) the least powerful role is inherited (NO ACCESS has higher priority than READER, READER has higher priority than EDITOR, etc.).

4. Fourth priority (if there are no direct person or organization assignments from the current folder and up to the top folder) is the default top folder role of the person (initially defined or later updated).

8.5 **Organization**

8.5.1 **New**

Organizations in SimDM can be used just to group person objects together by a criterion. Persons can, for example, be grouped to give all members the same access rights. The following dialog appears (see Figure 22) after the “Add organization...” context menu was selected.

![Add organization dialog](image)

**Figure 22. Dialog to add organization**

Combo box “Type” contains the following possible types for organization access rights.

- Group – all members have their own default access rights.
- Department – all members have their own default access rights.
- Admin – all members have administrator (manager) access rights. Users can create new persons, assign access rights to them, approve actions and so on.
- Editor – all members are editors. Users can create new folders, upload files and make some updates.
- Reader – members can not update the PS, but can add comments to objects.

“Members” control is used to select members for the organization. Later it will be possible to add/remove members from the organization (not implemented yet).

8.5.2 Update
Existing organization object can be edited later by selecting “Update…” context menu item for selected object in “Details” view. The same dialog (see Figure 22) appears. Text in all fields can be changed. Organization object is updated by clicking the “OK” button.

8.5.3 Remove
An organization is removed by the “Remove” entry in the context menu when you right-click on an organization’s name in the “All Items”-tab of the detail view.

To remove an organization from the entire product structure – not only from its current assignment - select the top folder of the model and select “Remove”. If the organization has already been assigned to a folder within the selected model, it will not be removed, but can not be assigned any more. This is indicated by the name of the organization being struck through in the detail view of the top folder. The assignment occurrences to lower level folders will not change appearances. Such partial removal can be undone by using the “Update …” entry in the organization context menu on the top folder.

8.5.4 Assign
Organization assignment can be used to change the default access rights of a specified group of persons (organization) for the selected folder (branch of Product Structure). The following dialog appears (see Figure 23) for the “Assign organization…” context menu for the current folder.

![Assign organization to folder: Design](image)

**Figure 23. Dialog to assign organization to folder**
Combo box “Organization” contains all available organizations for the PS. Combo box “Type” contains following access rights (types):

- **Admin** – all members have administrator (manager) access rights. User can create new persons, assign access rights for them, approve actions and so on.
- **Editor** – all members are editors. User can create new folders, upload files and make some updates.
- **Reader** – all members cannot update PS, but can only add comments to objects.
- **[No access]** – all members lose any access rights for specified folder (branch).
- **[Use default type]** – all members have theirs default access rights (admin, editor or reader).

An assignment object may be given a name. This should reflect the role of the organization in this context and should, thus, be different from the name of the assigned organization. Text fields “Description” and “Comment” are also optional and may be omitted.

Note: For repeated assignments of the same organization to the same folder the latest assignment will overwrite the previous one.

### 8.6 Methods

Method objects define how tasks shall be done.

#### 8.6.1 New method

Methods are defined for a product structure first, before they can be assigned to individual folders as part of task descriptions (see 8.6.2 New task). Many product structures may be defined for a product structure; a folder may be assigned many tasks descriptions.

To define a method use menu item “New Method…” of the context menu of the product structure folder. The following dialog will pop up:

![Dialog to add method](image)

“Description” should contain a clear guidance for how to perform a task.

Text field “Comment” is optional and can be omitted.

The following context menu items exist for task methods:

- New comment…: see 8.8 Comment
- Remove: If the method is not yet used in a task assignment, it is deleted. If it is in use already, further use will be disabled, that is, the method can not be used in task assignments any more.
8.6.2 New task

A task object specifies a job that shall be done by a person using one or several methods for a selected folder. The following dialog appears (see Figure 25) after triggering the “New task…” context menu item for a folder.

The combo box “Person” contains all available persons for the PS. The combo box “Method” contains all available methods for the PS.

![New task dialog](image)

**Figure 25. Dialog to create a task**

“Name” is mandatory and shall contain a human interpretable text under which the task shall be known. “Description” is optional and may contain details of the task specifications potentially with reference to input data, tools and resources.

The controls “To start” and “To finish” should contain date and time when the task is supposed to be started and finished.

8.7 Approval

Approvals may be assigned to folders for communication among co-workers. Before being assigned, however, they need to be defined. Each product structure may have its specific set of approvals. Besides this generic approval functionality SimDM offers the concept of a final approval which is required for baselining folders.

8.7.1 New

New approval definitions can be defined for a Product Structure with the “New approval…” context menu item. The following dialog appears (see Figure 26).
Figure 26. Dialog to define a type of approval

Combo box “Type” contains the following possible types of approval outcomes:

- negative,
- neutral,
- positive.

This categorization may be used for automatic processing of approvals; it will not appear in the details view of a folder, only in its property view.

Text field “Name” is the text that this type of approval will be known as. It is mandatory and will appear in the details view.

Text fields “Description” and “Comment” are optional and can be omitted.

Note: If an existing type of approval is defined once again, the previous definition is updated; no new approval is created.

8.7.2 Assign

One or more approval definitions can be assigned to folders. The following dialog appears (see Figure 27) after selection of “Assign approval…” context menu item for the selected folder.
One of approval definitions (that were earlier created for PS) shall be selected in the “Approval” combo box. An assignment object may be given a name. This should indicate the role of the approval in this context and should, thus, be different from the name of the assigned type of approval. Text fields “Description” (for example, details of the role of the approval) and “Comment” are optional and may be omitted.

Note: A folder may be assigned as many approvals as there are users with write access to this folder. A user may only assign one approval. A second approval assignment by a person replaces the previous assignment of this same person.

**8.7.3 Final approval**

To finally accept the contents of a folder use the “Final approval…” menu item of the product structure or of the folder context menus.

This will not only approve the selected folder, but also all underlying branches. The names of finally approved product structure folders turn to italics font. Only folders with such approval can be included in baselines. Only administrators of a product structure can give final approval.

The function works like a toggle: apply the function a second time on a folder, and the approval will disappear.

Note: To speed up the change of folder name font to, for example, italics, close and open the relevant part of the product structure tree.

Note: Final approval can not be redone for archives that have been exported.
8.8 Comment
All objects (except references to folder objects) can be commented.

8.8.1 New
Usually, the dialog to create an object has text field for filling in a first comment. Further comments may be added later. The following dialog appears (see Figure 29) for the “Add comment…” context menu item.

![Add comments for item Analysis]

A comment has a header (“Name” text field) and a text itself (“Description” text field). Both text fields are mandatory.

8.8.2 New feedback
A comment can be commented; the second comment is then called a feedback. A series of related comments can be viewed as such in the property view.

8.8.3 Remove
To remove a comment select the “Remove” item from the comment context menu. A window will pop-up to receive your confirmation.

Note: The pop-up window asks in R6 wrongly for the “selected approval”, not for the “selected comment”.

8.9 Property
Folders may be assigned properties. The types of properties that are available for assignments are defined individually for each product structure. As with other product structure definitional items, only administrators have permission to define properties. Editors will typically assign them and give values for individual folders.

8.9.1 New
To introduce a new type of property fill the following into the pop-up window that is shown in Figure 30:

- **Name:** the human interpretable text string under which the property shall be commonly known.
- **Units:** the unit of measure for values of the property.
- **Description:** additional information that is useful to know of the property.
- **Type:** select one of the following entries to identify the nature of property values:
- boolean_property
- double_property
- integer_property
- string_property

**Applicable to:** select one or many of the following entries to identify which types of folders such property values may be assigned to: part, product, program, project, analysis, linear_static_analysis, linear_modes_and_frequencies_analysis, design and document.

**Optional/Mandatory:** specify whether a value for this property shall be given. If you select mandatory, you need to specify a Default Value.

**Vector/Scalar:** specify whether a value for this property shall be a vector, that is, a series of values, or a scalar, that is, a single value. For vectors specify lower and upper bound.

![Introduce property for folder: Ultralight Glider Anal...](image)

**Figure 30. Dialog for the definition of properties**

### 8.9.2 Remove

A property is removed by the “Remove” entry in the context menu when you right-click on a property’s name in the “All Items”-tab of the detail view.

To remove a property from the entire product structure – not only from its current assignment - select the top folder of the model and select “Remove”. If the property has already been given a value for a folder within the selected model, it will not be removed from the top folder, but can not be assigned any more. This is indicated by the name of the property being struck through in the detail view of the top folder. The assignment occurrences to lower level folders will not change appearances.
8.9.3 Assign

Properties that have been defined for the product structure by the administrator may be assigned to folders using the dialog shown in Figure 31. You select one of the available property types and add one or several values in the “Values”-field.

If the property is defined to be a vector, the vector values shall be separated by either ‘;’ or new line (‘Enter’ key).

![Figure 31. Assigning a property to a folder](image)

8.10 Export to archive

This function creates an archive package of an entire Product Structure, of one of its branches or of a baseline. For export of baselines and in-work packages, these need to be specified first by the corresponding root folder context menu items “New baseline...”, “New LOTAR AIP...” and “New In-work package ...”

When triggering the function from the context menu of a child folder you will immediately be prompted with a file browser window with the dialog “Save archive as...” to select the location for the archive zip-file. Depending on the type of package, the system suggests the following package names:

- `<model name>__archive__<node name>`
- `<model name>__in-work__<node name>`
- `<model name>__baseline__<baseline name>`

Provide your choice of folder and file name. If the identified file exists already, it will be overwritten.

When triggering the function from the context menu of the Product Structure folder, the following window pops up:
You may export the entire product structure, one of its in-work packages, one of its baselines or one of its LOTAR archives. For product structures you may or may not include its history, that is, all versions of all product structure folders. If this tick-box is not selected, only the current version is exported. The Baseline, In-work package and LOTAR fields are only selectable if you defined at least one baseline, in-work package or LOTAR archive. Baselines, in-work packages and LOTAR archives include only current folder versions; the history tick-box is, therefore, not relevant.

A background process creates the export package zip-file. You may, therefore, continue with other tasks during the creation and download processes. When they are completed, you will be notified by an alert window (see Figure 33).

The zip-file for archival has the following characteristics:

- the folder structure within the zip-file corresponds to the product structure, that is, each product structure folder represents an operating system folder;
- the top folder is always the product structure folder even if the archived folder is several levels within the product structure;
- the names of the files that are attached to the folders are maintained. However, to maintain uniqueness of folders on the operating system level, those folder names consist of the following three components: folder name, folder type and folder version. For example for a folder with only one version: "STEP Input DOCUMENT";
- the meta data of the product structure and its folders are exported into an ISO 10303-21 file that corresponds to the EXPRESS model of the OpenSimDM™ master model; this is included in the top folder of the zip-file;
- the OpenSimDM™ master model is converted to AP209e2, and the resulting P21 file is also included in the top folder of the zip-file.
• the text file “pdi.txt” that contains PDI.

Thus, when unzipping an archived file in your operating system, the product structure will be recreated as folder structure with the attached files within them.

An archived file can be imported back into OpenSimDM™ to create a new model within an arbitrary repository; see chapter 8.11 Import from archive.

Note: The following limitations apply currently:

1) File names shall be unique within a product structure.
2) Very large files, that is, 1GB and more, may cause the system to stop.
3) The mapping from the OpenSimDM™ master model to AP209e2 needs to be revised and completed.

8.11 Import from archive and model

The function “Import from archive...” can only be executed from the context menu of the repositories and models panel. You will be prompted with a Windows file browser to find the location of the zip-file. After having selected an appropriate SimDM zip-file you will be asked for the name of the model. Provide a name that is unique within the repository and that has a valid syntax (see 7.4). The archive will be added as a new model to the current repository.

The function “Import from model...” is available from context menus in the product structure panel. It enables you to reuse a previously defined and exported structure as a copy within the current structure.

![Select model](image)

**Figure 34. Pop-up window for “Import from model...”**

You can not import directly into a structure; you need to go via a new model. This is to enable quality control and adaptation of the imported structure before taking it in use in an operational structure.

The sequence of functions of “Export to archive...”, “Import from archive...” and “Import to model...” replaces copy/paste across repositories.

The imported product structure will be identical to the archived one, which may be a complete or a partial product structure, and includes copies of all files.

Note: As an archive does not include access rights, the imported archive has only default access rights.

Note: If an archive contains STEP-files, these are not automatically imported into models of their own; they will only be imported like any other file as blobs. Before being able to validate or query such STEP-files you need to execute the file context menu item “Import P21”. The server will find the corresponding file and read it into EDM. After this, “Validate” etc. will become available.
8.12 Child folders

A product structure consists of a single top folder, the product structure folder, and zero, one or many child folders, also called subordinate folders. Folders are the containers for files and various kinds of meta data. Folders may have different types. Folders may be versioned and may be configuration controlled by baselining their versions. In fact, the SimDM browser does not distinguish between folders and folder versions; the children in a product structure are folder versions.

Note: A folder may not have several parent folders; that is, the folder structure in OpenSimDM™ is not well suited to model bills of material where sub-assemblies may be used in several locations.

8.12.1 New

This function adds a new folder to an existing product structure, either directly under the top folder or below any other folder. The following dialog appears (see Figure 35) with the “New child…” context menu.

Combo box “Type” contains a number of folder types. Those types are treated equally by the application. Only the icons of the created folder objects are different to carry the different semantics.

The “Name” text field provides the identifier of the folder; this is a mandatory text value. The name appears beside the folder icon in the product structure. A folder may have several versions. Text field “Version” is not editable. The text “auto generated” means that the version identifier will be generated by the application.

![Figure 35. Dialog to create child folder](image)

Text fields “Description” and “Comment” are optional and can be omitted.

8.12.2 Remove

Selecting the “Remove” menu item triggers the following confirmation window to pop-up:
The text indicates that a folder can only be deleted when it has no more than one version. Otherwise this function will delete the latest folder version and not the folder itself.

8.12.3 Copy
“Folder>Copy” loads a copy of the folder and its underlying branches into memory for being pasted into another location. Meta data and files are not included. The original copy will not change at all.

8.12.4 Cut
“Folder>Cut” loads a copy of the folder and its underlying branches and meta data into memory for being pasted into another location. Files are not included. The original copy will be removed after pasting. The Cut-function can be cancelled by, for example, applying the Copy-function.

8.12.5 Paste
“Folder>Paste” creates a copy of a copied or cut folder and its underlying branches below the selected folder. Meta data and files are not included.

   Note: The copy of a read-only folder will allow write access.

   Note: A copied or cut folder can not be pasted outside of the product structure of the original folder.

8.12.6 Paste link
Pasting a copied folder as a link is like drag-and-drop of that folder; the action establishes a reference in the target folder to the copied folder. A link object appears in the detail view of the target folder. Double-click on the link object set the product structure tree pointer to that source folder.
8.13 Folder version
To capture the history of the development of a folder it is possible to establish versions of folders. Several versions of a folder can be modified in parallel. Parent-child relationships are always between the – in that context – current folder versions, not between the folders themselves. Baselines include folder versions, not folders.

8.13.1 New folder version
This functionality creates a version of the selected folder. The just created folder version becomes current instead of the selected one. The following message box (see Figure 38) appears after choosing the “New folder” → “New folder version” context menu item.

![Create version dialog](image)

Figure 38. Question to create new folder version

After clicking “Yes”, the new folder version is created. Just like folders, also folder versions have attributes “Type”, “Name” and “Description” (see “Properties” view) from the previous version. The new version references the same (identical!) children folders that the previous folder version referenced and still will reference. Objects of the following types are copied to the new folder version if they were assigned to the previous one:

- Assigned person
- Assigned organization
- Assigned property

8.13.2 Show version
A version of a folder can be displayed for itself in another product structure panel by using the folder context menu as shown below:

![Folder context menu](image)

Figure 39. “Show version” dialog

The current version number is greyed out; only bolded version numbers can be selected and shown.
8.13.3 Shift version

The folder version that is displayed as part of the product structure is member of this product structure. You may choose to change the member of the product structure to a different version of the same folder. You do this by “Shift version”; see Figure 41.

8.13.4 Remove version

A folder version is removed using the function for folder removal as there is no difference between a folder and a folder version; see 8.12.2.
8.14 File handling

Files are a class of objects in itself in SimDM; they are neither meta-data nor folders. Files do not appear in the product structure, but are always associated to a folder. It may be useful to create document folders and assign files to only those. Files have their own context menu, which is shown in Figure 42.

![Figure 42. Files context menu for AP209e2 files](image)

The context menu for files consists of the following menu items:

- **“Open”** – launches the application that opens the file (see 8.14.4)
- **“Open with”** – “Select application...” – launches the MS Windows browser so that you can find the application that you want to open the file with (see 8.14.5).
- **“Download”** – “Attached file...” – opens Windows file browser to let you select the location where the selected file shall be copied to
- **“Download”** – “CAX file...” – is only available for files that were successfully converted to the VCollab CAX-format (see chapter 11); such files are not explicitly listed in the detail view. Opens Windows file browser to let you select the location where the CAX-file shall be copied to.
- **“Text query...”** – opens dialog to specify a query into the selected file (see 8.14.6). This menu item is only available for AP209e2 files and only if they have been imported into a separate EDM model; for export packages that have been imported this is not the case.
- **“Validation”** -> “Validate...” – starts a validation of the selected file against its EXPRESS schema (see 8.14.7). No further user input required. This menu item is only available for AP209e2 files and only if they have been imported into a separate EDM model; for export packages that have been imported this is not the case.
- **“Validation”** -> “Open log” – downloads validation log and opens it.
- **“Validation”** -> “Remove log” – removes validation log on the server
- **“Import P21”** – starts the import of a previously uploaded STEP-file. This menu item only appears for STEP-files that have been re-imported via an export package. After successful completion menu items “Text query...” and “Validate...” will appear.
- **“Import P21”** -> “Open log” – downloads import log and opens it.
- **“Remove”** – removes selected file from the database after your confirmation.
- “Copy” – copies the reference to the current file (see 8.15), not the file itself. A consecutive “Paste” (Paste link) will establish a two-way link between this file location and the location of the paste-operation.

### 8.14.1 Assign and upload files

Files may be assigned to all kinds of folders, not only to folders of type “Document”. The files of a selected folder are listed in the middle (Details) view of the “PS browser” panel. Use the “Details” button in the tool bar to show or hide the “Details” view (see Figure 14).

Files from the local file system may be uploaded to the current server by the following three ways:

- Via the “Upload…” context menu item on the selected folder.
  The file for upload is selected in the “Original name:” field (see Figure 43).

- Via Drag-and-drop functionality.
  The file for upload is dragged from the “Local File Explorer” panel (View → Local File Explorer) and dropped into “PS browser” panel (“Tree” or “Details” view).

- “Windows explorer” can be used instead of the “Local File Explorer” panel.
  Note: Where drag-and-drop are available, several files can be uploaded at the same time. The “Upload file” dialog appears for each selected file.

![Image](Image)

**Figure 43. “New file -> Upload...” dialog**

The field “Original name:” represents the path to file that shall be uploaded. The “Select file” dialog appears when the “…” button is pressed.

After file selection, the “Type” field displays automatically the textual file type name (see chapter 4.5). If the file extension is not defined in the “File associations” table, “undefined type” is displayed in the “Type” field. In this case the logical file type “Document” will be assigned to the selected file. You may change this behaviour by registering the file extension using the “Tools > File associations” menu item (see 4.3).
Some file types are during upload converted to the VCollab CAX visualization format (see chapter 11). Both the original file and the CAX-file are stored in the SimDM database. The GUI, however, will only show the original file.

Before starting the upload you may add the following file meta data, which are intended as additional data when archiving the file:

**Owner:** In the owner field it is possible to enter a person or organization different from the uploading person as the owner of the file. If you check the check-box “Set current user as owner”, it will not be possible to enter anything in this field.

**Original format:** If the uploaded file is transformed from an original format, it is possible to enter the name of the original format in this field.

**Creating system:** Denote the original system that produced the file.

**Interface:** Denote the interface software that was used to convert from the original format, if the file was the result of any conversion.

**Operating system:** Denote the operating system requirements of the file.

Right after start of a file upload the file name appears in the “Details” view. This does not imply that the upload is completed already. Upload is an asynchronous process; it is completed when the progress bar in the lower left corner of the SimDM window disappears. In addition the user is notified by an alert window (see Figure 44).

Note: Upload time depends among others on the network capacity.

![Figure 44. Alert window after upload is finished](image)

### 8.14.2 New external file reference

The "New file -> External link" command stores only the file path of the file in the SimDM database, not the file itself. In addition it stores file size and last modification time. The file must be possible to open for read from both the SimDM client and the SimDM server. It is only files in the local network with file path like "\local_machine\folder_name\file_name.ext" that can be opened by this command.

When creating baselines that include references to external files, it is checked that the last modification date of the file is equal to the last modification date stored in the database. If the file is modified after the reference is stored in the database, a warning is given. The same test is performed when a referenced file is to be copied into an archival package. Here also a warning is given if the file is modified after the reference is stored in the database.

For files that are converted to the cax-visualization format the resulting .cax-file is stored in the folder of the external file.

It is emphasized that referenced files are outside the control of the SimDM system.
8.14.3 Download
Files from the server can be downloaded to the local file system by using “Download” context menu for the file object (“Details” view). The “Download” context menu has two items: “Attached file…” and “CAX file…”.

“Attached file…” item is available for any uploaded files. “CAX file…” item is available only for files that were converted to CAX file during upload.

“Download” requires selecting a local folder to download the file into. In this case standard dialog “Save file as…” appears. Download can take time for large files. When a file is downloaded, the users gets a notification as an alert window (see Figure 45).

![Download completed](image)

Figure 45. Alert window after file is downloaded

8.14.4 Open
“Open” downloads the selected file into a temporary folder on the client machine and opens the file by an appropriate viewer (see chapter 4.5).

Note: Some of the file types (CAD/CAE, AP203/AP209) are automatically opened in the “SimDM viewer” panel (see chapter 11), unless an external viewer was specified for these file types in Tools>File associations.

8.14.5 Open with
“Open with” menu contains one item for each specified external viewer in addition to the menu item “Select application…”. If only the file path of the file was uploaded into the database and not the file itself, the SimDM client will try to open the file with the original file path and download it to the target file path. If the referenced file had been modified after the reference to it is stored in the SimDM database, a warning is given.

8.14.6 Query
AP209e2 files can be queried. The queries browse through the contents of a single file. The file must have been imported into SimDM so that it exists as a model, not only as a file. This import will usually have taken place as part of the conversion to CAX.

The “Text query…” menu item will open the panel that is shown in Figure 47.

The following queries are included in this release:
The input fields in Figure 47 may change title with the selected query. Object ids are specified in these text input fields. The ids must be separated by space; ids that contain spaces must be enclosed by single quotes. Numerical ids can be specified as a range with a dash between the minimum and the maximum range value. Example:

```
SPC_3.0 12 13 21 120-123 "Load case 1"
```

The above line specifies the following ids: SPC_3.0, 12, 13, 21, 120, 121, 122, 123 and Load case 1.

**Figure 46. Queries implemented in this release**

**Figure 47. The text query panel is to the left**

**Maximum values**: the query will present maximum values (only applicable to some queries)

**Minimum values**: the query will present minimum values (only applicable to some queries)

**In case of survey queries:**

- **For each specified node over all specified load cases**: finds maximum or minimum for each specified object over all specified load cases
- **Over all specified nodes and specified load cases**: finds maximum or minimum of all specified objects and load cases
- **Execute**: starts the query
Save as: current query result can be stored as HTML file

Text queries have this name because the results are presented textually in a HTML window. Common for all text queries is that input parameters are object ids and that the query returns information about these objects.

There are three different types of text queries. These are:

1. Queries that return information about objects where you specify object id(s).
2. Queries that return information about objects with respect to load cases. You specify both objects id(s) and load case id(s). The load case id(s) are selected from a list of all load case ids in the AP209 model.
3. Maximum or minimum tensor value surveys. You specify either maximum or minimum type of survey by a radio button. The survey finds maximum or minimum by analyzing the specified objects in the specified load cases. One variant of the surveys finds maximum or minimum of all specified objects and load cases. Another variant finds maximum or minimum for each specified object over all specified load cases.

8.14.6.1 Model Query
This query returns information about FEA models. The query key is the fea_model ID.

The information displayed for each model is:

- Total number of nodes, total number of coordinate systems, total number of each type of element and total number of elements.
- Total number of control load cases
- For each control load case: Total number of constraints and applied loads differentiated on variable type (pressure, etc.)
- For each result load case indicate the existence of:
  - Deflections
  - Stresses
  - Strains
  - Element Forces

8.14.6.2 Node Query
This query returns information about the nodes that you specify in the input field. The query returns a table with one row per node. The table has the following columns:

- Node ID: the id of the node.
- Coordinate system ID: the ID of the coordinate system used to found the node (see clause 5.6.2 of 10303-104 for more details).
- Coordinate System Type: Either Cartesian, Cylindrical, or Spherical.
- Coord1, Coord2, Coord3: The coordinates in point subtype that specifies the position of the node.

8.14.6.3 Element Query
This query returns information about the elements that you specify in the input field. The query returns a table with one row per element. The table has the following columns:
- **Element_ID** – the id of the element
- **Type** – “Volume_3D”, “Volume_2D”, “Curve_3D”, ..etc.
- **Order** – For those element types where topology order is relevant: “Linear”, “Quadratic” or “Cubic”.
- **Shape** – For “Volume_3D” elements this column can be either "Hexahedron", "Wedge", "Tetrahedron" or "Pyramid". For "Volume_2D" or "Surface_3D" elements the column can be either "Quadrilateral" or "Triangle".
- **Property_ID** – ID of the property information of the element.
- **Material_ID** – The id of the element material. It is also a link to the query displaying this information.
- **Node_List** – The node IDs of the nodes attached to the element. It is also a link to the node query displaying information about these nodes.

### 8.14.6.4 Curve Element Property Query

This query returns information about the curve element properties the IDs of which are specified in the “Curve Element Property ID(s)” input field. The information displayed is:

- Description
- Cross-sectional_area
- Shear area
- Second moment of area
- Torsional constant
- Warping constant
- Location of Centroid
- Location of shear centre
- Location of non structural mass
- Non structural mass
- Polar moment

In addition information about End Offsets and End Releases is displayed.

### 8.14.6.5 Surface Element Property Query

This query returns information about the surface element properties the IDs of which are specified in the “Surface Element Property ID(s)” input field. The information displayed is:

- **Property_ID**
- Offset
- Non_structural_mass
- Non_structural_mass_offset
- Thickness
- Bending_thickness
- Shear_thickness
8.14.6.6  Point Element Property Query
This query returns information about the point element properties the IDs of which are specified in the “Point Element Property ID(s)” input field. The information displayed is:
  - Element_ID
  - Matrix_Type
  - Mass Matrix
  - Moments of Inertia
  - CoordSys_ID
  - Offset Vector

8.14.6.7  Directionally explicit Element Property Query
This query returns information about the directionally explicit element properties the IDs of which are specified in the “Directionally explicit Element Property ID(s)” input field. The information displayed is:
  - Property ID
  - Coordinate System ID
  - Freedom
  - Coefficient

This query is not implemented, yet.

8.14.6.8  Material Property Query
This query returns information about materials the IDs of which are specified in the “Material ID(s)” input field. The information displayed is:
  - Material_ID
  - Material_Type(s)
  - Linear elasticity
  - Mass density
  - Tangential coefficient of linear thermal expansion

8.14.6.9  Constraint Element Query
This query returns information about constraints on load cases. The constraints are specified by constraint id in the “Constraint ID(s)” input field, and the load cases are specified by selecting load case id(s) in the field “Load Case ID(s)”. For single point constraints the information displayed is:
  - Constraint_ID
  - Load Case_ID
  - Node_ID
  - CoordSys_ID
  - Freedom_Values - (typically x_translation, y_translation, z_translation, x_rotation, y_rotation, z_rotation)
8.14.6.10  Applied Load Query
This query returns information about applied loads on nodes in load cases. The nodes are specified by 
node id in the “Node ID(s)” input field, and the load cases are specified by selecting load case id(s) in 
the field “Load Case ID(s)”. The information displayed is:
- Load_Case_ID
- Node_ID
- CoordSys_ID
- Load Type
- Freedom_Values - (typically x_translation, y_translation, z_translation, x_rotation, y_rotation, 
z_rotation)

8.14.6.11  Displacement Query
This query returns information about displacements of nodes in load cases. The nodes are specified by 
node id in the “Node ID(s)” input field, and the load cases are specified by selecting load case id(s) in 
the field “Load Case ID(s)”. The information displayed is:
- Load_Case_ID
- Node_ID
- CoordSys_ID
- Freedom_Values - x_translation, y_translation, z_translation, x_rotation, y_rotation and 
z_rotation

8.14.6.12  Stress and Strain Query
This query returns information about stress and strain of elements in load cases. The elements are 
specified by element id in the “Element ID(s)” input field, and the load cases are specified by selecting 
load case id(s) in the field “Load Case ID(s)”. The information displayed is:
- Load_Case_ID
- Element_ID
- Variable – Either stress or strain
- CoordSys_ID
- Locations
- Values – if variable is stress: σ11, σ12, σ13, σ22, σ23, σ33 and if variable is strain: ε11, ε12, 
ε13, ε22, ε23, ε33.

8.14.6.13  Element Forces from Node Force Balance Query
The query keys are Element ID and Load Case ID. The information displayed is a table with the 
following columns:
- Element ID
- Node ID
- Load Case ID
- Coordinate System
- Degree of Freedom.
The table will have one row for each node of each specified load case and each specified element.
8.14.6.14 Displacement Survey
The query keys are Node ID and Load Case ID range, and a selection of maximum or minimum. For each node the survey reports the maximum or minimum displacement vector value in each component direction (x, y, z, rx, ry, rz) and resultant displacement value (sqrt(x*x+y*y+z*z)) for a single or range of node IDs, for a range of load cases. For each node, the information displayed is the same as for the Displacement Query, but repeated seven times for the node, once for each component of the displacement vector, and once for the resultant. Each repeated displacement vector component output line shall have the component that is the maximum or minimum underlined, and the corresponding Load Case ID output in the Load Case ID column.

8.14.6.15 Stress or Strain Survey
The query keys are Element ID and Load Case ID range, and a selection of maximum or minimum. For each element the survey reports the maximum or minimum stress or strain tensor value appropriate for the element type, the principle stress, and the Von Mises stress for a single or range of element IDs, for a range of load cases. For each element, the information displayed is the same as for the Stress or Strain Query, repeated as many times as there are components in the stress or strain tensor for that type of element. Each repeated stress or strain tensor component output has the maximum or minimum component underlined, and the corresponding Load Case ID output in the Load Case ID column.

8.14.6.16 Element Forces from Node Force Balance Survey
The query keys are Element ID and Load Case ID range, and a selection of maximum or minimum. For each element the survey reports, for each node in the element, the maximum or minimum force vector component in each component direction (x, y, z, rx, ry, rz) and the resultant translational load value (sqrt(x*x+y*y+z*z)), for a single or range of element IDs, for a range of load cases. For each element, the information displayed is the same as for the Element Forces from Node Force Balance Query, repeated for each of the component directions and the resultant, repeated for each of the nodes in that type of element. Each repeated force vector component output has the maximum or minimum component underlined, and the corresponding Load Case ID output in the Load Case ID column.

8.14.7 Validate
Before archival, STEP-files shall be validated. The validation result files shall be included in archival packages. Such validations run against the constraints in the EXPRESS schema that the STEP-file is said to be compliant with.
This release of the SimDM browser allows you to validate AP209e2 files. Other STEP-files are not validated as their EXPRESS schemas are currently not available to the SimDM browser. Currently validation options can be specified (see Figure 48).
Figure 48. Validation options

All validations are done against constraints in AP209e2, and a report is created. The report is presented to you on request after completed validation; see Figure 49.

Figure 49. Message after completed AP209e2 validation

The report file is stored in the database. When repeating the validation, different validation options can be chosen.

It is also possible to validate several STEP-files at the same time. Right-click on a folder and select “Check STEP-files”. The following window will pop-up.
Figure 50: Information window for “Check STEP-files...”
The application will then present the table in Figure 51 with all SEP-files that may have been or may be subject to validation. The same table will appear again after all selected validations have been performed.

Figure 51: Overview of STEP-files given by “CheckSTEP-files...” function

8.15 Link files and folders to folder
It is possible to create links (references) to folders and files. This is done by using Drag-and-drop functionality in the following way.

Note: A copy of the “PS browser” panel could be opened in the opposite panel container to support drag-and-drop. Use “Show PS copy” tool bar button on the “PS browser” panel.

Select and drag either a folder or a file, and drop it into the desired target folder (“Tree” or “Details” view). A dialog to create the file reference appears (see Figure 52).
The text box “Name” is set with file name by default. The name of file reference could be changed. “Description” and “Comment” fields are optional and may be omitted. As result a file link icon is placed into the folder that the file was dragged into.

When a folder reference is created, the following dialog appears (see Figure 53).

The “Name” field is read only. It represents the name of the referenced folder. The “Description” field is optional and may be omitted. As result folder link icons are placed into both the source and the target folder so that a two-ways link becomes available.

**8.16 Collections**

Folders and their data can be grouped into collections of the following three types:

- Baseline
- In-work package
- LOTAR Archive

These are explained in the sub-chapters below. Table 1 displays the principle differences.

<table>
<thead>
<tr>
<th>Table 1: Differences in types of folder collections</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baseline</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>Baseline</td>
</tr>
</tbody>
</table>
In all cases folders shall be contiguous, that is, they shall be connected by parent-child relationships or parent-parent relationships.

The collections sub-menues are only available in the context menu of the top product structure folder; see Figure 54.

<table>
<thead>
<tr>
<th></th>
<th>Validated</th>
<th>Approved</th>
<th>Contiguous</th>
<th>Export</th>
</tr>
</thead>
<tbody>
<tr>
<td>In-work package</td>
<td>-</td>
<td>-</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>LOTAR Archive</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Figure 54. Three collection type sub-menus in top folder context menu

All three types of collections become available for export after having been created (see menu item “Export to archive...”, 8.10). Baseline and LOTAR Archives require final approval, which will turn them into read-only collections. Only LOTAR Archives must be validated, that is, the STEP-files in such archives shall have successfully passed the “Validation>Validate...” function for “Full validation” (see 8.14.7).

Note: As long as a LOTAR archive has not been exported, yet, its final approval may be reverted. After export this will not be possible any more, and the archived branch will stay read-only.

8.16.1 Baselines
A baseline is a single folder or a set of folders that can be used as a basis for comparison during a development process of a product structure. A baseline may also be established as the basis for subsequent engineering activities. Such activities may be attributed with formal approval.

8.16.1.1 New baselines
Baselines are created by an administrator and from the product structure context menu only. Selecting the “New baseline...” menu item opens a panel that replaces the product structure panel for the time of defining the baseline; see Figure 55.
A baseline shall be contiguous. It will always include the product structure folder, which will become the direct parent of the start folder of the baseline.

Only folders with “Final approval” can be included in baselines. The names of such folders are written in italic in the baseline panel, whereas folders that cannot be selected are shown in grey.

Folders for inclusion into the package are selected by clicking in the tickbox to the left of each folder. A baseline structure may start at any folder. Subfolders are automatically selected and cannot be deselected.

A baseline shall be given a name and may be given a description.

As soon as a baseline is created its name becomes available in the menu items “Baseline>Show” and “Baseline>Remove”.

8.16.1.2 Show baseline

Baselines may be reviewed from the product structure context menu only and by any user with read access. A new product structure panel is opened to display the selected baseline; see left panel in Figure 56. The baseline has read-only access for all types of users that are assigned to the owning product structure.
8.16.1.3 Remove baseline
Baselines can only be deleted by an administrator and from the product structure context menu only. After having selected a baseline for removal you are asked for a confirmation; then all traces of it will disappear from the system.

8.16.2 In-work package
An in-work package is a single folder or a set of folders that are collected into a zipped package for

- back-up,
- data exchange,
- re-use.

An in-work package is in principle not different from a baseline (see 8.16) except that the items in an in-work package do not need to fulfill any requirements, such as validation and approval. On the other hand an in-work package can neither be treated nor converted into an official archive.

8.16.2.1 New in-work package
In-work packages may be created by any editor and from the product structure context menu only. Selecting the “New In-work package...” menu item opens a panel that replaces the product structure panel for the time of defining the in-work package; see Figure 57.

An in-work package shall be contiguous. It will always include the product structure folder, which will become the direct parent of the start folder of the in-work package.
Folders for inclusion into the package are selected by clicking in the tickbox to the left of each folder. An in-work package structure may start at any folder. Subfolders are automatically selected and cannot be deselected.

![Create In-work Package](image)

**Figure 57. Creation of an In-work package**

An in-work package shall be given a name and may be given a description. As soon as an in-work package is created its name becomes available in the menu items “In-work Package>Show” and “In-work Package>Remove”.

8.16.2.2 Show in-work package

In-work packages may be reviewed from the product structure context menu only and by any user with read access. A new product structure panel is opened to display the selected in-work package; the appearance is similar to “Show baseline” in Figure 56.

8.16.2.3 Remove in-work package

In-work packages can be deleted by any editor (or only the owner?) and administrators. The function is available from the product structure context menu only. After having selected an in-work package for removal you are asked for a confirmation; then all traces of it will disappear from the system.

8.16.3 LOTAR Archive

A LOTAR Archive is a single folder or a set of folders that are ready for export to an archive. The folder or branch needs to be finally approved (see 8.7.3) and all STEP-files need to have completed full validation successfully (see 8.14.7).

8.16.3.1 New LOTAR AIP

LOTAR archival information packages (AIP) may be created by administrators and from the product structure context menu only. Selecting the “New LOTAR AIP...” menu item opens a panel that replaces the product structure panel for the time of defining the LOTAR AIP; see left panel in Figure 58.

A LOTAR AIP shall be contiguous. It will always include the product structure folder, which will become the direct parent of the start folder of the archived branch.
Folders for inclusion into the package are selected by clicking in the tickbox to the left of each folder. A LOTAR AIP structure may start at any folder. Subfolders are automatically selected and cannot be deselected.

A LOTAR AIP shall be given a name and may be given a description. As soon as a LOTAR AIP is created its name becomes available in the menu items “LOTAR package>Show” and “LOTAR package>Remove”.

8.16.3.2 Show LOTAR AIP
LOTAR archival information packages may be reviewed from the product structure context menu only and by any user with read access. A new product structure panel is opened to display the selected in-work package; the appearance is similar to “Show baseline” in Figure 56.

8.16.3.3 Remove LOTAR AIP
LOTAR archival information packages can only be deleted by the owner and by administrators. The function is available from the product structure context menu only. After having selected a LOTAR archival information package for removal you are asked for a confirmation; then all traces of it will disappear from the system.

8.17 Find
The “Find”-function helps you to retrieve items from the OpenSimDM™ server that match a given text string. The function is triggered from the product structure root folder context menu and will open a panel of its own aside the product structure panel (see Figure 59).
The topmost input field is for specifying the search string. This search string is case sensitive. If you look for something that is written in uppercase, it will not be found if you state the search pattern in lowercase and vice versa.

The following wildcards may be used in the “Find text pattern” field:

Table 2. List of wildcard options for the Find... function

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@</td>
<td>Matches any letter</td>
</tr>
<tr>
<td>^</td>
<td>Matches any upper case letter</td>
</tr>
<tr>
<td>?</td>
<td>Matches any character</td>
</tr>
<tr>
<td>&amp;</td>
<td>Matches reminder of string</td>
</tr>
<tr>
<td>#</td>
<td>Matches any digit</td>
</tr>
<tr>
<td>$</td>
<td>Matches a substring terminated by a space character or end-of-string</td>
</tr>
<tr>
<td>*</td>
<td>Matches any number of characters</td>
</tr>
<tr>
<td>\</td>
<td>Begins a pattern escape sequence</td>
</tr>
<tr>
<td>!</td>
<td>Negation character (used with the other characters).</td>
</tr>
</tbody>
</table>

Note: These are the wildcards defined in ISO 10303-11, the EXPRESS reference manual.

The matching occurrences are listed below the input form. Each occurrence has a “Show”-button. Clicking on this will open the product structure at the location of this occurrence.

9 Local file explorer

This panel represents the file structure on the local client machine as a tree. It is possible to Drag-and-drop files between “Local file explorer” and “Product Structure browser” panels.

Note: The “Windows Explorer” application can be used instead of the “Local file explorer” panel. But it is only possible to drag one (or several files) from “Windows Explorer” and drop it into the “Product Structure browser” panel, not vice versa.
10 Help panel
The panel presents the help system for the application in HTML format (not implemented, yet; for the time being this file is displayed instead)

11 Geometry and FEA viewer
The “SimDM viewer” panel (see Figure 60) displays the 3D model of one or several uploaded files. The panel is opened and closed by the main menu item View>Viewer panel. The VCollab Presenter application provides the viewing capability.
AP203, AP209e2 and NASTRAN files (bdf and op2) are during upload automatically converted to the VCollab visualization format CAX. Both the source file and the CAX file are stored in the database; they can be downloaded individually. Only data sets of the following ISO 10303 Application Protocol (AP) schemas are recognized and converted to CAX:
- AP203_CONFIGURATION_CONTROLLED_3D_DESIGN_OF_MECHANICAL_PARTS_AND_OBJECTS_MIM_LF
- AP209_MULTIDISCIPLINARY_ANALYSIS_AND_DESIGN_MIM_LF
- AP242_MANAGED_MODEL_BASED_3D_ENGINEERING_MIM_LF
- AUTOMOTIVE_DESIGN
- STRUCTURAL_ANALYSIS_DESIGN

The viewer is launched when you open (“Open” context menu) an AP203, AP209e2 or NASTRAN file; VCollab Presenter controls become available for manipulating the 3D model.
You may specify a different viewer in the main menu item Tools>File associations.
Figure 60. “SimDM viewer” panel

Note: CAX files that are uploaded by you (vice automatically generated) and then opened will not be shown in the Viewer panel, but by the application that is associated with the CAX extension.